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| 1. TEDS IEEE 1451.4 INTRODUCTION I

The DPM-3 is a TEDS IEEE 1451.4 Plug and Play Smart Load Cell Meter. TEDS, or
Transducer Electronic Data Sheet, is a set of electronic data in a standardized format
defined within the IEEE 1451.4 standard. Stored in an EEPROM, this data specifies what
type of sensor is present, describes its interface, and gives technical information such as
sensitivity, bridge type, excitation, etc.

The DPM-3 automatically detects when a TEDS IEEE 1451.4 compliant Load Cell/Torque
Sensor has been connected to it by using a built-in EEPROM detector. Once such a sensor
has been detected, the DPM-3 displays a front panel TEDS indicator light, reads the
EEPROM, stores the information in memory, and performs an automatic configuration. The
built-in, sensor-related EEPROM may be of any of the following types: DS1973/DS2433,
DS2431 or DS1971/DS2430A. The automatic system configuration function performs all
steps needed to calibrate the TEDS IEEE 1451.4 compliant Load Cell/ Torque Sensor and
DPM-3 as a system. This includes the configured precision of 32 bits, 19 bits or 11 bits and
the configured excitation voltage. Using the DPM-3 with a TEDS IEEE 1451.4 compliant
Load Cell/ Torque Sensor is as easy as plugging a mouse into a computer, making it a true
plug and play experience.

The DPM-3 is safety certified to UL 61010-1 and to CSA C22.2#61010-1. It carries the ETL
certification mark for the USA and Canada.

| 2. GENERAL INTRODUCTION I

DPM-3 digital panel meters are a versatile, cost-effective solution to a wide variety of
monitoring and control applications. They are easily set up to produce an accurate display
of weight, load or direct reading of microvolts. Setup can be via front panel pushbuttons or
the meter’s serial interface. Digital scaling of zero and span provides direct readout in engi-
neering units. Digital calibration of all ranges eliminates drift associated with potentiometers
found in non-microcomputer-based meters. Selective security lockout of the front panel keys
protects against accidental changes to the meter setup.

A unique method of analog-to-digital conversion provides 60 conversions per second (50 for
50 Hz operation), while integrating the signal over a full line cycle for maximum noise
rejection. Self-calibration cycles reduce the average reading rate to 56 per second (47 for
50 Hz). This fast read rate provides an accurate display of peak signal input and quick
response in control applications.

An adaptive auto-filter automatically selects a time constant appropriate for the encountered
signal noise level. This ensures stable displayed readings and outputs while responding
rapidly to changes of the input signal that exceed a selected threshold value. Input signal
polarity may be selected as normal or reverse.

The DPM-3 uses a lightweight, high-efficiency switching power supply that operates from
either AC or DC voltages and complies with safety regulations. The meter can be powered
worldwide without changes to the supply. An optional low voltage supply operates on 10 to
48 Vdc from batteries or 12 to 32 Vac from sources such as 400 Hz aircraft power. Both
supplies have an isolated 10 Vdc excitation supply to power transducers.
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The NEMA-4 (IP65) 1/8 DIN case is made of high impact 94V-0 UL-rated plastic. Mounting
is from the front of the panel and requires less than 110 mm behind the panel. All wiring is
by removable plugs conforming to UL61010C safety standards. All output options are
isolated from meter and power ground by 250 Vac minimum.

Alarm or setpoint control is provided by an optional relay board with two or four Form C 8A
mechanical relays or two or four Form A 120 mA solid state relays. The setpoints may be
latching or non-latching, be energized above or below the setpoint, or operate in a fail-safe
mode. The relays can operate from the filtered signal to reduce relay chatter or from the
unfiltered signal for fastest response. Snubber circuits and a programmable relay switching
time delay extend relay contact life.

An isolated analog output of 4-20 mA, 0-20 mA, 0-10V or -10 to +10V can be provided by an
optional analog output board. The output is linearized to the display and can operate from
the filtered or unfiltered signal input. It can be scaled via front panel pushbuttons or the
meter’s serial interface.

Optional RS232, RS485, or USB serial interfaces allow the DPM-3 to communicate bidirec-
tionally with computers, PLC’s or other digital devices. An optional USB-to-RS485 converter
board allows a primary DPM-3 to be interfaced to a computer and to be the device server for
a network of up to 31 other DPM-3’s on an RS485 bus, while itself retaining all capabilities
of a meter.

Windows-based software is available from Transducer Techniques to program our meter
and transmitters via a PC using the serial interface. This software can be downloaded at no
charge from http://www.transducertechniques.com. Please see Section 19 for details.

3. RECEIVING & UNPACKING I

Your DPM-3 meter was carefully tested and inspected prior to shipment. Should the meter
be damaged in shipment, notify the freight carrier immediately. In the event the meter is not
configured as ordered or the unit is inoperable, return the unit to Transducer Techniques for
repair or replacement. Please include a detailed description of the problem.

| 4. SAFETY CONSIDERATIONS I

Visually inspect the instrument for signs of damage. If damaged, do not attempt to operate.

A Warning: Use of this equipment in a manner other than specified may impair the pro-
tection of the device and subject the user to a hazard. Visually inspect the unit for signs of
damage. If the unit is damaged, do not attempt to operate.

Caution:

e This unit must be powered with AC (mains) from 85-264 Vac with the high voltage power
supply option, or 12-32 Vac (10-48 Vdc) with the low voltage power supply option. Verify
that the proper power option is installed for the power to be used. This meter has no AC
(mains) switch. It will be in operation as soon as power is connected.
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e The 85-264 Vac mains connector (P1 Pins 1-3) is colored Green to differentiate it from
other input and output connectors. The 12-32 Vac (10-48 Vdc) mains connector is colored
Black.

¢ Do not make signal wiring changes or connections when power is applied to the instru-
ment. Make signal connections before power is applied. If reconnection is required,
disconnect the AC (mains) power before such wiring is attempted.

e To prevent electrical or fire hazard, do not expose the instrument to excessive moisture.

e Do not operate the instrument in the presence of flammable gases or fumes; such an
environment constitutes a definite safety hazard.

e This meter is designed to be mounted in a metal panel. Verify the panel cutout dimen-
sions, and mount according to instructions.

Symbols applicable to this product:

¢ GTb ve ETL Mark. Indicates that product conforms to UL Std. 61010-1 and is certified
— to CAN/USA Std. C22.2 No. 61010-1

Intertek
4006497

C € CE Mark. Indicates that product meets EU safety, health and environmental
requirements.

Caution (refer to accompanying documents)

Caution, risk of electric shock.

Earth (ground) terminal.

Equipment protected throughout by double insulation or reinforced insulation.

Both direct and alternating current.

RoHS Symbol. Indicates that product is free from hazardous substances defined
in EC directive 2002/95/EC.

WEEE Symbol. Indicates that product should be recycled and not disposed of as
general waste.

= ENEB B

Operating environment:

The meter is Class Il (double insulated) equipment designed for use in Pollution degree 2.



| 5. CONNECTOR WIRING INFORMATION I

5.1 CONNECTOR LOCATION

Connectors for signal and power are UL-rated screw-clamp terminal blocks that plug into
mating jacks on the printed circuit board. Communication connectors can be a USB jack, a
single RJ11 jack for RS232, dual RJ11 jacks for RS485, or dual RJ45 jacks for RS485.

5.2 J1-POWER AND DIGITAL CONTROLS

ACHI (+DCHN 1[OX Notes: 1) Non-isolated digital control inputs 1

ACLO (DCRET) 2 |OI and 2 are menu selectable.

EARTHGROUND 3 [E 2) +5V Output may be connected to J1-4

CONTROL INPUTB (+5VOUT)* 4 [ instead of digital input B, see page 40.
CONTROL INPUTA™ 5 |
DIGITALGROUND 6 | g
5.3 J5-SIGNAL INPUT _
Shield TEDSLOADCELL
-EXCITATION 1 ,

TEDSDATA 2 Load Cell
-SIGNAL 3 | Force Sensor
+SIGNAL 4 ~ Torqgue Sensor

+EXCITATION 5 —.-_ Pressure Transducer
TEDSGROUND 6 Full Wheatstone Bridge
Note: Pins 3 and 6 are jumpered
NON-TEDSLOADCELL
-1T0VEXCITATION 1 (W E
NG 2R ' Load Cell
-SIGNAL 3| n B . : Force Sensor
+SIGNAL 4 N E — Torque Sensor
+10VEXCITATION 5 o Bu — Pressure Transducer
NC 6 mB Full Wheatstone Bridge

Note: For wiring color, refer to Load Cell Calibration Certificate or to
www.transducertechniques.com/wiring-color-code.aspx
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P2 - SETPOINT CONTROLLER
DUAL MECHANICAL RELAY OUTPUTS

DUAL SOLID STATE RELAY OUTPUTS

ALARM 1 N/OCONTACT 1| mm ALARM1 1| mm— DCORAC
ALARM 1 COMMON 2| [ ALARM1 2| [ (— NOTUSED
ALARM 1 N/CCONTACT 3| [N ALARM1 3L EEHI— DCORAC
ALARM 2 N/OCONTACT 4 ALARM2 4 Immf— DCORAC
ALARM 2 COMMON 5| [mm ALARM2 5| @I[— NOTUSED
ALARM 2 N/CCONTACT 6| [iN ALARM?2 6| [INl— DCORAC

QUAD MECHANICAL RELAY OUTPUTS QUAD SOLID STATE RELAY OUTPUTS

RS485 INTERFACE - FULL DUPLEX

ISO GND I

6 = GND ISO GND I GND
§§§ 5 BTX 5 mmm
4 = ATX 4 wmm
ATX 3 - ARX ATX/ARX | 3 mmm ATX / ARX
ES.Tg)(GND 2 = = ARX BTX/BRX |2 == ,_I'_ BTX /BRX
1 - i GND ISO GND 1 - | GND

ALARM1 N/OCONTACT 1[ fim ALARM1 N/OCONTACT 1[ frm
ALARM1&2 COMMON 2| [ ALARM1&2 COMMON 2| [
ALARM2 N/OCONTACT 3| [IW ALARM2 N/OCONTACT 3| [XW
ALARM3 N/OCONTACT 4] Tam ALARM3 N/OCONTACT 4] Tam
ALARM3 &4 COMMON 5| fam ALARM3 &4 COMMON 5| fam
ALARM4 N/OCONTACT 6| [Im ALARM4 N/OCONTACT 6| [Im
P3 - SERIAL COMMUNICATIONS P4 - ANALOG OUTPUT
UNIPOLAR CONNECTIONS
RS232 INTERFACE Computer 420 mA or 0-50 mA OUTPUT 11 T5s
N/C 5 0-10V OUTPUT 2| [
SO GND | 5 s GND ISOLATED GROUND ~ 3|_[Im
RX
Y o o BIPOLAR CONNECTIONS
RTS  |omm RTS REFERENCE or RETURN 1| frm
N/C = -10V 1o +10V OUTPUT 2| [Im
NC 3l

RS485 INTERFACE - HALF DUPLEX

6-'—

RS485-MODBUS - FULL DUPLEX RS485-MODBUS - HALF DUPLEX

(A') RXDO 1 TXDO
(B") RXD1 2 TXD1
3 .
(B) TXD1 4 RXD1 (B) TX/RXD1 D1
(A) TXDO 5 RXDO (A) TX/RXDO DO
6 .
7
ISO GND 8 GND ISO GND GND




| 6. MECHANICAL ASSEMBLY I

REMOVING THE REAR PANEL

First remove any connectors. Use one hand to press in the two sides of the rear of the
case, and the other hand to press down the two protruding tab releases at the top of the
rear panel (see figure below). This will unhook the rear panel from the case.

Retaining tab —

with tab release

— Retaining tab

with tab release

Retaining tab l l . .
\ \ | — Retaining tab

Rear Panel

REMOVING THE ELECTRONICS

With the rear panel removed, grasp the power supply board to the left and signal condi-
tioner board to the right, and carefully slide the electronic assembly out through the rear of
the case (see figure below).

INSTALLING NEW OPTION BOARDS

Options boards plug into the main board at the front of the meter. These are plug-and-play
and may installed in the field. They will be recognized by the software, which will provide
access to the menu items associated with that board. If necessary, remove rear panel
knockouts for new boards. Boards plug into connectors as follows:

Option Board Main Board Jack Rear Panel Jack
Power supply P11 J1
Relay board P12 J2
Serial interface board P13 J3
Analog output board P14 J4
Signal conditioner board P15 J5

-



Note: Corresponding main board and option board connectors have the same number of
electrical lines. When an option board is correctly installed, the top and bottom edges of
the main board and option board are aligned.

REASSEMBLING YOUR METER

Slide the electronics assembly into the case until the display board is seated flush against
the front overlay. Insert the bottom tabs of the rear panel into the case, then carefully align
the board connectors with the openings in the rear panel. If necessary, remove any rear
panel knockouts for new option boards that may have been installed. Ensure that all option
boards are properly aligned with the molded board retaining pins on the inside of the rear
panel. With the rear panel in place, reinstall the input/output screw clamp terminal plugs.

PANEL MOUNTING

Ensure that the panel mounted gasket is in place against the back of the bezel. Turn the
two mounting screws counterclockwise until the space between the mounting pawl and the
rear of the gasket is greater than the panel thickness. Insert the meter in the panel cutout.
Turn the mounting screws clockwise until the meter is securely mounted in the panel. Do
not overtighten.

FRONTVIEW REAR VIEW

{0197 in)i TOP VIEW SIDE VIEW

-
l | “-Mounting Pawl

PANELCUTOUT

102 mm
(4.02in)

45 +0.6/-0.0mm
(1.772 +.024/-0.0in)

10 mm
v v 03%0)
92 +0.8/-0.0 mm
- : (3.622 +.032/-0.0in)
A g2 J3 s us A
The DPM-3 uses UL / VDE rated detachable o o
screw terminal connectors for signal and power. ; #‘A’ ; o



| 7. FRONT PANEL SETUP KEYS I

TEDS
Alarms status indicator
indicators
1 through 4
I-‘L_‘F Tr;if'I:;:_?Jr.'.‘.[?}..l Tech
Alarms key
Menu key (Reverse menu)

Peak display key Reset/Tare key
(Digit select) (Value select)
Meter Front Panel

There are four front panel keys, which change function for the Run Mode and Menu Mode,
effectively becoming eight keys. The keys are labeled with alphanumeric captions (MENU,

MENU MODE KEY ACTION

In the Menu Mode, pressing a key momentarily advances to the next menu item. Holding
down a key automatically advances through multiple menu items for fast menu navigation.

KEYS IN RUN MODE

> MENU Key. Pressing MENU from the Run Mode enters the Menu Mode. Pressing
wew | MENU repeatedly will step the meter through the various menu items (if these have not
been locked out) and then back to the Run Mode.

> | PEAK Key. Pressing PEAK normally causes the peak value of the input signal to be

| displayed. The peak display then blinks to differentiate it from the normal present value
display. Pressing PEAK again returns the display to the present value. The PEAK key
can also be programmed to display Valley, alternating Peak or Valley, or to Tare the
reading to zero. When Peak or Valley is selected, periodic horizontal bars at the top of
the display indicate Peak, and periodic horizontal bars at the bottom indicate Valley.

»= | RESET/TARE Key. Pressing RESET with PEAK resets peak and valley values.
reser | Pressing RESET with ALARMS resets latched alarms. Pressing RESET with MENU
performs a meter reset (same as power on). Meter reset can also be applied via a rear
panel connector. Pressing and releasing RESET/TARE tares the meter value to zero.

< ALARMS Key. Pressing ALARMS once displays the setpoint for Alarm 1. Pressing it
aarvs| - ggain displays the setpoint for Alarm 2. Pressing it again returns to the present value.
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KEYS IN MENU MODE

>

MENU

PEAK

TARE

RESET

ALARMS

(Menu). Pressing MENU steps the meter through all menu items that have been
enabled and then back to the Run Mode. With the DC signal conditioner board and no

option boards, available menu items are [, 30l ae, IEEG, T, YT

YT, GO, G, YL, k], (RF., (Y, IXYX. If a change has been made to a

menu item, that change is saved to non-volatie memory when the MENU key is
pressed next, and is displayed briefly.

(Digit Select). Pressing digit select from the InPut menu brings up all meter functions
available with the meter's signal conditioner. For the Load cell signal conditioner, these

are, igy and EISY.

e Pressing digit select from the SEtuP, ConfFG, FiLtr, Lo in, Lo rd, Hi in, Hi rd, tArE,
Loc 1, Loc 2 or Loc 3 menus items sequentially selects digit positions 1 - 5, as
00000

indicated by a flashing digit: [OSes), ST, ST, NI

(Value Select). Pressing value select for a flashing item (digit position or decimal point
position) will increment that item. Pressing MENU will save any changes.

items are brought up in reverse order.

-11 -



| 8. ENABLING & LOCKING OUT MENU ITEMS I

For security reasons and ease of meter operation, any and all menu J1

items may be disabled or "locked out" so that they are no longer
directly accessible from the front panel. Each function to be disabled
is set to "1" in menu items Loc 1, Loc 2, Loc 3 or Loc 4, and each
function to be enabled is set to "0." The top menu items Loc 1, Loc
2, Loc 3 and Loc 4 can in turn be locked out by installing an internal
hardware jumper. With the jumper installed, the operator only has
access only to enabled menu items. With the jumper removed, the
user also has access to menu items Loc 1, Loc 2, Loc 3 and Loc 4.

SETTING HARDWARE LOCKOUT JUMPER

To access the lockout jumper, remove the rear panel per Section 6
and locate jumper “a” in the lower portion of the power supply board

next to the input connectors (see figure at right).

SETTING SOFTWARE LOCKOUTS

When setting up the meter, it may be necessary to
enable specific menu items by setting the corres-
ponding lockout digit to 0. Be sure to reset the lockout
digit to "1" if you do not want the menu item to be
changed by an operator.

Press the MENU key until Loc 1, Loc 2 Loc 3 or Loc

4 is displayed, as desired. Note: the hardware
lockout jumper must be removed (see above).

Press PEAK to display the lockout status, consisting
of 1’s and 0’s. The left digit will flash. Press > again
to step to the next digit, which will flash.

00000

12345

Press RESET to set the flashing digit to "0" to enable
the menu item or to "1" to disable. Press MENU to
enter. See the table to the right for list of menu items
that can be enabled or disabled.

-12 -
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Enabled or Disabled
Menu Items

Loc 1

1 - Input type selection.

2 - Meter setup, configuration
& decimal pt.

3 - Filter selection.

4 - Scale or Lo, Hi input.

5 - Offset or Lo, Hi reading

Loc 2

2 - Alarm setup.

3 - Alarm setpoint value
programming.

4 - Analog output scaling.

5 - Serial interface setup.

Loc 3

2 - View peak value

3 - View alarm setpoints

4 - Reset (peak & latched alarms)
5 - Reset (meter reset)

(TEDS only)

1 - Serial number

2 - Units of measure

3 - Calibration date

4 - Calibrator’s initials & bridge 1D
5 - Meter reset pushbutton




| 9. TEDS SIGNAL CONDITIONER IN TEDS MODE I

9.1 INTRODUCTION

The DPM-3 is a TEDS IEEE 1451.4 Plug and Play Smart Load Cell Meter. TEDS, or
Transducer Electronic Data Sheet, is a set of electronic data in a standardized format
defined within the IEEE 1451.4 standard that is stored in an EEPROM. This data specifies
what type of sensor is present, describes its interface, and gives technical information such
as sensitivity, bridge type, excitation, etc. The DPM-3 will automatically detect when a
TEDS IEEE 1451.4 compliant Load Cell/Torque Sensor is connected to it, each and every
time, by a built in EEPROM detector. Once a TEDS Sensor has been detected, the DPM-3
displays a front panel TEDS indicator light, reads the EEPROM and stores the information
in memory and performs an automatic configuration. The automatic system configuration
function performs all steps needed to calibrate the TEDS IEEE 1451.4 compliant Load Cell
/ Torque Sensor and DPM-3 as a system, including selecting the correct sensor excitation.
Using the DPM-3 with a TEDS IEEE 1451.4 compliant Load Cell / Torque Sensor is as
easy as plugging a mouse into a computer, making it a true plug and play experience.

9.2 SCALING

When a DPM-3 connected to a TEDS transducer is powered on, the meter reads the data
stored in the transducer. The excitation supply is automatically set to the correct value and
the DPM-3 calculates the correct scaling to calibrate the meter and the transducer as a
system. The jumper on the signal conditioner board must be set for the 50 mV range. See
Section 13.1. If the Maximum Physical Value of the TEDS sensor exceeds 100,000, the
calculated scale and offset are divided by 10 and the reading is in 10's of units.

If the full scale of the transducer is 50 pounds, the meter will display 50 at full scale output.
If more resolution is desired, the meter decimal point can be set so that the meter will read
50.0, 50.00, or 50.000. In this example, if another unit of measure, such as kilograms, is
desired, there are two alternatives.

If the meter has a serial communication board installed, TEDS Reader_Editor software
can be used (see Section 24 "Accessories" for information). The electronic data sheet for
your transducer can then be read electronically and be displayed on a computer screen.
The values can be modified (e.g., to display kilograms instead of pounds), and then written
back to the transducer.

The meter Menu item "Tare," digits 4 and 5, can be set to 1 to configure the meter as a
non-TEDS transducer type.

9.3 Error Messages

If there is a problem with the TEDS connection between the meter and the TEDS trans-
ducer, one of the following error messages will be displayed at power on or when plugging
in a TEDS transducer while the power is on:

Err1 - TEDS data line shorted

Err2 - No Presence pulse from TEDS

Err 3 - Improper Presence pulse width

Err4 - TEDS family code in ROM in error

Err 5 - TEDS checksum error in the first or second 32 bytes
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9.4 Software

TEDS Reader-Editor Software, PIN DPM-3-TRES, is available from Transducer Tech-
niques. This software allows the user to read and edit information stored in the TEDS
transducer. See Section 24 "Accessories" for ordering information.

9.5 Meter Setup

When setting up the meter, it may be necessary to enable some of the menu items.
See Section 8 “Enabling and Locking Out Menu Items” for the procedure.

MENU > DIGIT > VALUE “/R\E
KEY MENU SELECT KEY | r=« SELECT KEY RESET
SEtuP| (0 0 i} Noise minimized for 60 Hz
Meter Setup Power line frequency d Noise minimized for 50 Hz
[ 00 ] A=Reset, B = Meter Hold
Rear control inputs d A = Function Reset B = Peak or Valley Displ.
A&B P A = Meter Hold B = Peak or Valley Displ.
True = logic 1 (OV or B A = Meter Hold B = Tare
tied to digital ground) Pl A=Peakor Valley B=Tare
False = logic 0 (5V or | & A= Tare B =Reset
open) B A=0,B =0, decimal point 1= XXXXX
A =1, B =0, decimal point 1 = XXXX.X
A =0, B =1, decimal point 1 = XXX.XX
A =1,B =1, decimal point 1 = XX.XXX
A =0, B =0, decimal point 2 = XXXX.X
A =1, B =0, decimal point 2 = XXX.XX
A =0, B =1, decimal point 2 = XX.XXX
A =1,B =1, decimal point 2 = X.,XXX.X
B A = Function Reset B = Display Blank
8 A=Hold B = Display Blank
I A= Peak or Valley B = Display Blank
[E A=Tare B = Display Blank
A = Valley Display B = Peak Display
B A=Tare B = Tare Reset
Both control inputs A and B set to logic 1 for
selections &, , [, [€ = Function Reset.
Both control inputs A and B set to logic 1 for
selections I, fl, K, B, &, B, 3, [} = Meter Reset
ConFG [} Peak Display (max reading)
Meter Operation of front panel |l Valley Display (min reading)
Configuration | PEAK button E Peak (1st push), Valley (2nd push)
| 00 | l] Normal Input Signal Polarity
Signal polarity ﬂ Reverse Signal Polarity
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MENU > DIGIT > VALUE “/R\E
KEY MENU SELECT KEY | P=« SELECT KEY RESET
FiLt 00000 [} Alarm unfiltered
Filtering Alarm filtering d Alarm filtered
00000 [} Peak & Valley unfiltered
Peak & Valley filtering  Peak & Valley filtered
00000 [l Display batch average every 16 readings
Display filtering ﬂ Display filtered signal
00000 [l Low adaptive filter threshold level
Adaptive filter threshold | il High adaptive filter threshold level
00000 [} Autofilter
Input signal filtering. fl Batch average, 16 readings
Can be applied to dis- P Moving average, 0.08 sec.
play, setpoint, analog B Moving average, 0.15 sec.
output, data output. Pl Moving average, 0.3 sec.
E Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
B Moving average, 9.6 sec.
A Unfiltered
dEc.Pt d.dddd

Decimal point

selection.

Determines decimal
point position & reading
resolution.

d.ddddjldd.ddd@iddd.ddgdddd.diddddd.
Relelelels Press * key to shift decimal point.
Decimal point is stored in TEDS memory.

Display shows TEds instead of StorE.

Option board dependent menu items

ALSEt JALS34JdEU1HIdEU2H|JEU1bldEU2bIdEU3HIDEU4HIDEU3bIDEU4b

Menu items related to alarm setup These will only appear if a relay board is detected. If
so, please see Section14.

AnSEt An Hi |
Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 15.

Tare & TEDS
selections.

CloJoe Front panel
pushbutton Tare.

Front panel tare enabled
Front panel tare disabled

==

Auto-Tare.

Tare after meter reset
No tare after meter reset

s[eJog TEDS Plug and
Play indicator.

Plug and Play indicator enabled
Plug and Play Indicator disabled

TEDS Plug and Play.

Plug and Play enabled
Plug and Play disabled

BE | =B= | (==

-15 -




MENU KEY | >

MENU

DIGIT > VALUE TR
SELECT KEY | =« SELECT KEY RESET

Option board dependent menu items

SEr 1 JSEr 2 JSEr 3 JSEr 4] Addr

Menu items related to serial communications. These will only appear if an RS232,
RS485, or USB 1I/O board is detected. If so, see Section 16.

Transducer Serial No.

If the serial number is 6 digits or less, press the Peak key
once to display all digits . If the serial number is
greater than 6 digits, press Peak once to display the first
digits (P, and press the Peak key again to

display the remaining digits EEELYL). Read only.

---

Units of measure. Read none kgf
onl. _
In-oz In-Ib ft- Ib kgf-
-
kgf-cm N-cm Pa psi bar
CALdALt LVODKY  Transducer calibration date in mm.dd.yy format
Cal date (month, day, year). Read only.
CALInL Initials of the person who performed the transducer calibration.
Cal initials Read only. Characters used are:
CALPE Requwed transducer calibration interval in days. Read only.
Cal period
(M —Id | LN or MITERS or MIEER® Identifies whether meter is monitoring
Bridge ID bridge A, bridge B or bridge C.
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| 10. SETUP OF NON-TEDS TRANSDUCERS I

10.1 SCALING METHODS
Three methods are selectable for scaling the meter, as follows:

Scale and Offset Method (using calculated scale and offset). This method requires that you
calculate the required scale and offset values and enter them into memory when the meter
displays FY:YM= and [§Jg@3.. No calibration signals need to be applied to the meter.

Coordinates of 2 Points Method (using values from sensor's calibration certificate). With this
method, you enter the low input signal value, the display value for the low signal, the high input
signal value, and the display value for the high input signal value. These values are entered
when menu items [IRYTY, XL, EIHIE and EIRE are displayed. No calibration signals need to
be applied to the meter with this method, which is the most commonly used.

Reading Coordinates of 2 Points Method (applying a known weight or load). When using
this method, the meter calculates the proper scaling and offset values, entering them into
memory. The meter is connected to your sensor and looks at the values of the input signals to
calibrate the meter and transducer as a system.

10.2 Implementing Scale and Offset Method (using calculated scale factor and offset)
Apply power and press the MENU key until 3105 appears on the display.

Press the PEAK key, and four digits will appear on the display. Continue pressing the PEAK
key until Digit 4 begins to flash [JJOJ8. Make this digit a 0 by pressing the RESET key until 0
appears. Store the change by pressing the left MENU key. Perform any other programming
changes are required for your application.

10.3 Implementing Coordinates of 2 Points Input Method (using values from the sensor's
calibration certificate)

Apply power and press the MENU key until J3ig appears on the display.

Press the PEAK key, and four digits will appear on the display. Continue pressing the PEAK
key until Digit 4 begins to flash . Make this digit a 1 by pressing the RESET key until 1
appears. Store the change by pressing the MENU key. Reset the meter.

Press the MENU key until appears. Using the PEAK and RESET keys, enter the low
input value. Push the MENU key until appears. Using the PEAK and RESET keys, enter
the low reading to be displayed. Repeat this procedure for [RIIY] and [FIRgs. Perform any other
programming changes that are required for your application.

10.4 Implementing Reading Coordinates of 2 Points Method (applying a known load)
Apply power and press the left MENU key until J3illg appears on the display.

Press the PEAK key, and four digits will appear on the display. Continue pressing the PEAK
key until the Digit 4 begins to flash [[JOIY. Make this digit a 2 by pressing the RESET key
until 2 appears. Store the change by pressing the left MENU key. Reset the meter.

Go to Section 11 and perform the procedure of applying known low and high loads. Perform
any other programming changes that are required for your application.
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| 11. METER SCALING BY APPLYING KNOWN LOADS I

Apply power and press the left MENU key until appears on the display. Press the
PEAK key, and 4 digits will appear on the display. Continue pressing the PEAK key until
the Digit 4 begins to flash [[JOEJY. Make this digit a 2 by pressing the RESET key until 2
appears. Store the change by pressing the left MENU key. Reset the meter. Connect the
meter to your sensor or transducer. Use the procedure below to scale your meter by

applying known loads.

MENU KEY | >

MENU

DIGIT SELECT >
KEY

PEAK

TARE

AN

RESET

VALUE
SELECT KEY

Press the W key.

Lo In will appear on the
meter display. Apply the low
known load.

m Press the ? key.

The meter will begin to take
readings and display the low
signal value.

store the Lo In (low signal)
value.

m Press the 2 key.

Hi In will appear on the
meter display. Apply the high
known load.

XY Press the| = key.

The meter will begin to take
readings and display the high
signal value.

store the Hi In (high signal)
value.

Press the W key.

Lo Rd will appear on the me-
ter display. Enter the desired
low load reading value.

m Press the ? key

to select a digit, which will
flash.

0.00000.0000m0.0000
0.0000[0.0000

select a value from 0 to 9 for
the flashing digit. The deci-
mal is fixed by dEC.Pt.

m Press the (2 key.

Hi Rd will appear on the me-
ter display. Enter the desired
high load reading value.

Press the ? key

to select a digit, which will
flash.

0.0000j§0.00000.0000
0.0000[0.0000

select a value from 0 to 9 for
the flashing digit. The deci-
mal is fixed by dEC.Pt.
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| 12. TEDS SIGNAL CONDITIONER WITH NON-TEDS TRANSDUCERS I

MENU > DIGIT SELECT > VALUE SELECT KEY M/R\E

KEY MENU KEY PEAK RESET
I tI ignal Load cells. Factory d
nput signa oad cells. Factory de-
type fault scaling is 50 mV FS | 20.00 50.00 100.0f 250.0 500.0
20, 50, 100, 250, 500 mV full scale.
DC millivolts
SEtuP| 00 00 i} 4-1/2 digit meter, counts by 1
Meter Setup Display type d 5-digit remote display (+99,999)
P 4-1/2 digit meter, counts by 10
B 3-1/2 digit meter
00 00 i} Noise minimized for 60 Hz
Power line frequency d Noise minimized for 50 Hz
i} Scale and offset method
Meter scaling method d Coordinates of 2 points method
E Reading coordinates of 2 points method
00 00 il 1=Reset, 2 =Meter Hold
Rear connector control d 1 = Function Reset 2 = Pk or Valley Disp.
inputs 1 & 2 K 1 = Meter Hold 2 = Pk or Valley Disp.
True = |ogic 1 (OV or E 1 = Meter Hold 2 =Tare
tied to digital ground) P! 1=Peakor Valley 2= Tare
False = 0 (5V oropen) | & 1= Tare . 2=Reset
B 1=0,2=0, decimal point 1= XXXXX
1=1,2=0, decimal point 1 = XXXX.X
1=0, 2=1, decimal point 1 = XXX.XX
1=1,2=1, decimal point 1 = XX.XXX
1=0, 2 =0, decimal point 2 = XXXX.X
1=1,2=0, decimal point 2 = XXX.XX
1=0, 2=1, decimal point 2 = XX.XXX
1=1,2=1, decimal point 2 = X.XXX.X
B 1 = Function Reset 2 = Display Blank
8 1 =Hold 2 = Display Blank
P 1 =Peak or Valley 2 = Display Blank
B 1=Tare 2 = Display Blank
1 = Valley Display 2 = Peak Display
B 1="Tare 2 = Tare Reset
Both control inputs 1 & 2 set to 1 for selections
P, B I\, [8 = Function Reset.
Both control inputs 1 & 2 set to 1 for selections
0, @ K B B B £, B = Meter Reset.




MENU DIGIT SELECT >
Vet > KEY VALUE SELECTKEY = A\
ConFG 000 O i} Not rate of change
Meter Operation as a rate of d Rate x 0.1
Configuration | change meter. P Rate x 1
Extended meter only. K Ratex 10
I Rate x 100
B Rate x 1000
B Rate x 10000
000 0 [} Peak Display. Also selects “Peak” in
Operation of front panel “Peak or Valley” at connector above.
PEAK button and rear d Valley Display. Also selects “Valley” in
connector for Peak or “Peak or Valley” at connector above.
Valley Display P Peak (1st push), Valley (2nd push)
000 0 i} Normal signal polarity
Signal polarity. I Reverse signal polarity
000 0 B Linear input
Nonlinear input scaling i Custom curve linearization
Extended meter only..
FiLt 00000 i} Alarm unfiltered
Filtering Alarm filtering ﬂ Alarm filtered
00000 [} Peak & Valley unfiltered
Peak & Valley filtering d Peak & Valley filtered
00000 i} Display batch average every 16 readings
Display filtering d Display filtered signal
00000 ] Low adaptive filter threshold level
Adaptive filter threshold | High adaptive filter threshold level
00000 ] Autofilter
Input signal filtering. d Batch average, 16 readings
Can be applied to dis- | A Moving average, 0.08 sec.
play, setpoint, analog 3 Moving average, 0.15 sec.
output, data output. Pl Moving average, 0.3 sec.
E Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
8 Moving average, 9.6 sec.
A Unfiltered
dEc.Pt d.dddd d.ddddfidd.dddffddd.ddfldddd.dlilddddd.
Dec. point Decimal point flashes. .ddddd
selection




MENU
KEY

>

MENU

DIGIT SELECT
KEY

PEAK

TARE

VALUE SELECT KEY

RESET

Scaling method

“Scale and Offset” if selected under 8]S4

SCALE Select [ thru £ for flashing first digit, [f) thru {§

Scale factor | RYRNN WXNhD MLkl | for other flashing digits. Select decimal point
Selet digit to flas location when decimal point is flashing.

OFFst )Y | Select K thru £ for flashing first digit, i) thru £

Offset value 0.0000 for other flashing digits. Decimal point location
Select digit to flash. is selected by [T

Scaling method

“Coordinates of 2 points” if selected under 3

ANls) CNINE BN | Select B thru [g for flashing first digit, [i] thru g

Low signal 0.0000[§0.0000 for other flashing digits. Decimal point is set by

input Select digit to flash. input range chosen.

Lo rd INls) CNINN BRI | Select B thru [g for flashing first digit, [i] thru g

Desired read- | iXelsli]s] (XeleleN) for other flashing digits. Decimal point is set by

ingatLoIn. | select digit to flash. dEC.Pt

Hi In | ANl ONTNNE GNOINNE | Select [ thru B for flashing first digit, [i] thru ]

High signal 0.0000§0.0000 for other flashing digits. Decimal point is set by

input. Select digit to flash. input range chosen.

Hi rd | ANls) CNING BRI | Select B thru [g for flashing first digit, [i] thru g

Desired read- | (X)) XN for other flashing digits. Decimal point is set by

ing at Hi In. Select digit to flash. dEC.Pt

Scaling method “Reading coordinates of 2 points” if selected under J3illg

[ 0.021 [ 0.0218

Low signal Apply a low reference Press 4 to store the low signal input in the

input. signal to the meter. meter.

Hi In | 20.094 20.094]

High signal Apply a high reference Press 4 to store the high signal input in the

input. signal to the meter. meter.

Lord 0.00000.00000.0000N0.0000

Desired read- | fXoNT AXaLN) Select & thru [g for flashing first digit, [i] thru g

ing at Lo In. Select digit to flash. for other flashing digits. Decimal point is set by
dEC.P{}

Hi rd | 0.0000[§0.0000[§0.0000[MN6.7500

Desired read- | SEY SEORIN Select [ thru £ for flashing first digit, {i] thru £

ing at Hi In. Select digit to flash. for other flashing digits. Decimal point is set by

dEC.Pt}
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Option board dependent menu items

ALSEt JALS34]dEU1H|dEU2H|JEU1bldEU2bJdEU3HIDEU4H|DEU3bIDEU4b

Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Section14.

AnSETt | An Hi |
Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 15.

MENU DIGIT SELECT >
e i | | kEY VALUE SELECTKEY | A
(N Front panel i} Front panel tare enabled
Tare selec- pushbutton Tare. d Front panel tare disabled
tions.

0000 [l Tare after meter reset

Auto-Tare. ﬂ No tare after meter reset

Option board dependent menu items

SEr 1 |SEr 2|SEr 3|SEr 4] Adadr

Menu items related to serial communications. These will only appear if an RS232,
RS485, or USB I/O board is detected. If so, see Section 16

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in
turn be locked out by a hardware jumper. Please see Section 8.
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| 13. LOAD CELL & MICROVOLT SIGNAL CONDITIONER I

This section provides setup instructions to set up the DPM-3 signal conditioner for use with
load cells or strain gauges, or as a microvolt meter. The meter’s built-in, isolated 10 Volt,
120 mA excitation supply will power up to four 350 ohm load cells in parallel.

13.1

13.2

RANGE SELECTION VIA JUMPERS

Input JUMDers Full Scale b c
Range P Display H EH B

+20 mV e + 20000

+ 50 mV a + 50000

+ 100 mV b + 10000

+ 250 mV c + 25000

+ 500 mV d + 50000

Notes 1. See Section 17 to select 10V excitation.
2. Jumpers are 2.5 mm (0.17).
3. If a TEDS sensor is connected, jumper for £ 50 mV.

MENU SELECTION
Display in engineering units can be programmed by either the Scale and Offset Method,
Coordinates of 2 Points Method, or Reading Coordinates of 2 Points Methods.

With the Scale and Offset Method, scale and offset are calculated as follows, and are
then entered manually. The example below is for 0 to 20 mV = 0 to 100.00.

Input span = Hi signal in — Lo signal in Input span =20 mV -0 mV =20 mV
Input ratio =Input range / Input span Input ratio =20 mV /20 mV = 1.00
Display span = Hi display — Lo display Display span = 10000 — 0000 = 10000

Display ratio = FS Display / Display span Display ratio = 20000/ 10000 = 2.00

Scale Factor = Input ratio / Display ratio Scale Factor = 1.00/2.00 = 0.5000

Offset = — (Lo signal in / Input span) x Offset = — (0 mV /20 mV x 10000) + 0000
Display span + Lo display = 0000

With the Coordinates of 2 Points Method, values for low signal input, low display
reading, high signal input and high display reading must be entered manually. For
example, if the desired scaling is 0 to 30 mV = 0 to 500.0, the 50 mV full scale range
would be selected and values would be entered as follows:

Lo in =00.000 Lo rd = 0000.0
Hi in = 30.000 Hi rd = 0500.0

In the Coordinates of 2 Points example below, 0 to 20 mV = 00000 to 50000. During
setup, it may be necessary to enable some menu items. See Section 8 for information.
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MENU KEY >

DIGIT SELECT >
KEY PEAK

TARE

VALUE SELECT KEY | N\

MENU

Press V to display InPut
(input type).

| Strnl
Press ? key until Strn
(ratiometric) is displayed.

RESET

50.0, 100.0, 250.0 or 500.0

mV.
| SEtuP 30 00 00 10
Press| < to display SEtuP | Press|% to select digit, 12345

(basic setup). See Section
18 for description of digits
1-5.

which will flash.

Press W to display ConFG
(configuration). See Section
18 for description of digits 1 -
5.

00000

12345

Press ? to select digit,
which will flash.

00000

12345

| dEc.Pt

Press| % to display dEcPt | Press 2 to display decimal | Press £ to change decimal
(decimal point). point location. point location.

Press W to display Lo in Press ? to select digit, Press 5 to set digit values.

(low signal input value).

which will flash. Decimal

point is fixed by input range.

Set to 00.000 mV. Leftmost
digit may be set to 0 thru 9

and -0 thru -9.
00000 00000
Press F to display Lo rd Press ? to select digit, Press W to set digit values

(desired meter reading at
low signal input).

which will flash. Decimal
point is fixed by dEc.Pt

Set to 0.

Press W to display Hi in
(high signal input value).

00.000

Press ? to select digit,
which will flash. Decimal

point is fixed by input range.

20.000

Set to 20.000 mV.

Press| < to display Hi rd
(desired meter reading at
high signal input).

Press B to select digit,
which will flash. Decimal
point is fixed by dEc.Pt.

operating mode and display the value of the input signal.
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| 14. DUAL OR QUAD RELAY OUTPUT OPTION I

An optional relay board may be installed in the

meter main board at plug position P2, adjacent

to the power supply board. Four board ver- Alarm status
sions are available: 2 or 4 relays, mechanical 1',[';1‘:(')°uatﬁrz —
or solid state. Once installed, the relay board is 9
recognized by the meter software or PC-based

Instrument Setup software, which will bring up the appropriate menu items for it. These menu
items will not be brought up if a relay board is not detected. All relay boards offer a choice of
operating modes: normally off or on, latched or non-latched, hysteresis band, deviation band,
alarm based on the filtered or unfiltered signal, and selectable number of readings in alarm
zone to cause an alarm.

KEYSTROKES FOR VIEWING & CHANGING SETPOINTS

to make conversions and performs setpoint control. If the ﬁ (Peak) key is pressed while a

setpoint is displayed, conversion stops and the setpoint can be changed. After pressing f
you have 30 seconds, or the meter reverts to the normal display. To view setpoints, menu item
Loc3, digit 2, must have been set to 0. To change setpoints, menu item Loc2, digit 2, must
have been set to 0.

ALARMS KEY < DIGIT SELECTKEY | 2, ey e SELECT A
300.24 200.00 295.00

Press f (Alarms) Current setpoint 1 value blinks, and To change setpoint 1 value,
to display Alarm 1 Alarm 1 LED indicator lights. Press V press f to change
setpoint. to select a digit, which will blink. selected blinking digits.

395.00 305.00
Press |-, (Alarms) Current setpoint 2 value blinks, and To change setpoint 2 value,

to dlsplay Alarm 2 Alarm 2 LED indicator lights. Press V press f to change
setpoint. to select a digit, which will blink. selected blinking digits.

395.00 305.00
Press |<~, (Alarms) | Current setpoint 3 value blinks, and To change setpoint 3 value,

to dlsplay Alarm 3 Alarm 3 LED indicator lights. Press V press f to change
setpoint. to select a digit, which will blink. selected blinking digits.

395.00 305.00
Press ==, (Alarms) | Current setpoint 4 value blinks, and To change setpoint 4 value,

to dlsplay Alarm 4 Alarm 4 LED indicator lights. Press V press f to change
setpoint. to select a digit, which will blink. selected blinking digits.
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KEYSTROKES FOR SETPOINT SETUP
If the MENU 2 key does not work, see Section 8 “Enabling & Locking Out Menu Iltems.”

MENU KEY | DIGIT SELECT KEY | . Xé\l?UE ZaUEcr A
[} Relay 10n Relay 2 on
Alarm Setup for Relay state when d Relay 1 off Relay 2 on
relays 1 & 2 if alarm is active. Pl Relay 1 on Relay 2 off
detected. Relay 1 off Relay 2 off
Press < until l] Alarm 1 auto reset Alarm 2 auto reset
ALSEtis displayed. | Alarm latching or non- |l Alarm 1 latching ~ Alarm 2 auto reset
latching (auto reset). P Alarm 1 auto reset  Alarm 2 latching
Alarm 1 latching Alarm 2 latching
[} AL1 active high AL2 active high
Alarm operates atand |l AL1 active low AL2 active high
above setpoint (active |# AL1 disabled AL2 active high
high) or at and below AL1 active high AL2 active low
setpoint (active low). Bl AL1 active low AL2 active low
B AL1 disabled AL2 active low
B AL1 active high AL2 disabled
AL1 active low AL2 disabled
B AL1 disabled AL2 disabled
i} AL1 band deviation AL2 band deviation
Hysteresis mode or d AL1 hysteresis AL2 band deviation
band deviation mode Pl AL1 band deviation AL2 hysteresis
AL1 hysteresis AL2 hysteresis
ﬂ No deviation or hysteresis in menu.
i} After 1 reading Bl After 16 readings
Number of consecutive | ll After 2 readings B After 32 readings
readings in alarm zone | A After 4 readings B After 64 readings
to cause an alarm. After 8 readings After 128 reading
[} Relay 3 on Relay 4 on
Alarm Setup for Relay state when 1 Relay 3 off Relay 4 on
relays 3 & 4 if alarm is active. Pl Relay 3 on Relay 4 off
detected. Relay 3 off Relay 4 off
[} Alarm 3 auto reset Alarm 4 auto reset
Alarm latching or non- |l Alarm 3 latching Alarm 4 auto reset
latching (auto reset). Pl Alarm 3 auto reset Alarm 4 latching
Alarm 3 latching Alarm 4 latching
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MENU KEY >, DIGIT SELECTKEY | 2, ey e SELECT A
ALS34 00000 i} AL3 active high AL4 active high
Alarm Setup for Alarm operates at and d AL3 active low AL4 active high
relays 3 & 4 above setpoint (active Pl AL3 disabled AL4 active high
(continued) high) or at and below AL3 active high AL4 active low

setpoint (active low). Bl AL3 active low AL4 active low
B AL3 disabled AL4 active low
B AL3 active high AL4 disabled
AL3 active low AL4 disabled
B AL3 disabled AL4 disabled
00000 i} AL3 band deviation AL4 band deviation
Hysteresis mode or d AL3 hysteresis AL4 band deviation
band deviation mode Pl AL3 band deviation AL4 hysteresis
(see Glossary) AL3 hysteresis AL4 hysteresis
00000 W] After 1 reading Bl After 16 readings
Number of consecutive | ll After 2 readings E After 32 readings
readings in alarm zone Pl After 4 readings B After 64 readings
to cause an alarm. After 8 readings After 128 reading
BEVER Alarm 1 | (Xls ONOLONle GMeITel | Select [ thru B for flashing first digit, [i] thru ]
hysteresis 0.0000H0.0000 for other flashing digits. Alarms will activate
DEUZH Select digit to flash above the setpoint by the value entered and
hvst _Alarm 2 J deactivate below the setpoint by the value
ysteresis entered.
DIV Alarm 1 | DNOQ0IS OXOTNele OMOIISlY | Select B thru f] for flashing first digit, {i] thru £
band deviation 0.0000M0.0000 for other flashing digits. Alarms will activate
DEU2b, Select digit to flash above and below the setpoint by the value
band d AI?.rm 2 9 entered and will deactivate in the middle of
and deviation the band.
BIEHVETR Alarm 3 | (XoQ0l XNl GO | Select K thru E for flashing first digit, i) thru £
hysteresis 0.0000M0.0000 for other flashing digits. Alarms will activate
Select digit to flash. above the setpoint by the value entered and
E]Etn}] _Alarm 4 g deactivate below the setpoint by the value
ysteresis entered.
OIFVELY Alarm 3 | (XOI0]0) ONJolels) BNl | Select K thru [ for flashing first digit, i) thru [
band deviation 0.0000§0.0000 for other flashing digits. Alarms will activate
GBIV Alarm4 | Select digit to flash. above and below the setpoint by the value

band deviation

entered and will deactivate in the middle of
the band.
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| 15. ANALOG OUTPUT OPTION I

An optional analog board may be installed in the meter at rear panel jack position J4, adjacent
to the signal conditioner board. Once installed, this board is recognized by the meter, which
will bring up the appropriate menu items for it. These will not be brought up if an analog output
board is not installed.

The analog output can be a 0-20 mA, 4-20 mA or 0-10V unipolar signal with respect to isolated
ground, or a bipolar -10V to +10V voltage signal with respect to a reference return line.
Unipolar or bipolar operation is selected by a jumper. A unipolar current or voltage output is
selected at the connector. Unipolar 4-20 mA or 0-20 mA current is selected in software.

UNIPOLAR CONNECTIONS
4-20 mA or 0-20 mA OUTPUT
0-10V OUTPUT

ISOLATED GROUND

BIPOLAR CONNECTIONS
REFERENCE or RETURN
-10V to +10V OUTPUT 2
N/C 3

=)=

LG EN]

=k}

Unipolar current of voltage: Jumper a
Bipolar -10 to +10 voltage: Jumper b

The low analog output (0 mA, 4 mA, 0V, or -10V) may be set to correspond to any low
displayed reading An Lo. The high analog output (20 mA, OV or 10V) may be set to corres-
pond to any high displayed reading An Hi. The meter will then apply a straight line fit between
these two end points to provide an analog output scaled to the meter reading.

KEYSTROKES FOR SETUP
If the MENU 2 key does not work, see Section 8 “Enabling & Locking Out Menu Iltems.”

MENU KEY | DIGIT SELECT KEY | . x‘é‘bUE ZaUECr KN
AnSEt [ 00 [} 0-20 mA current output
Analog Output Setup. | Analog output signal d 0-10V voltage output
Press < until AnSEtis | selection. Pl 4-20 mA current output
displayed (requires -10 to +10V voltage output
analog output board) [ 00 [} Analog output unfiltered

Analog output filtering. ﬂ Analog output filtered
0.0000[§0.00000.0000 Select & thru £ for flashing first
Low displayed value 0.000000.0000 digit, [i) thru g} for other flashing
for 0 mA, 4 mA, OV, or | gelect digit to flash. digits. Decimal point location is
-10V output fixed by [o/50l g selection.

An Hi | 0.0000[§0.0000f0.0000 Select [l thru [ for flashing first
High displayed value | fYeWIS AL digit, [i) thru ] for other flashing

for 20 mA or 10V out- | geject digit to flash. digits. Decimal point location is
put fixed by [¢|JeHMgi selection.
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| 16. SERIAL COMMUNICATION OPTIONS I

A serial communications board may be connected to the DPM-3 meter main board at plug
position P13 (middle position). Available boards are RS232, RS485 (with dual RJ11 connec-
tors), RS485 Modbus (with dual RJ45 connectors), USB, and a USB-t0-RS485 converter. The
dual connectors of RS485 boards are wired in parallel to allow daisy chaining of addressable
meters without the use of a hub. Three serial communication protocols are selectable for all
serial boards: Custom ASCII, Modbus RTU, and Modbus ASCII.

A USB-t0-RS485 converter board allows a DPM-3 meter to be interfaced to a computer and
to be the device server for a network of up to 31 other meters on an RS485 bus, while itself
retaining all capabilities of a meter. The remote meters need to be equipped with our RS485
digital interface board DPM-3-OPT-TRS485. This board has dual 6-pin RJ11 jacks, which are
wired in parallel to allow multiple meters to be daisy-chained using readily-available 6-wire
data cables with no need for hand-wiring or an RS485 hub. The outer two wires are used for
ground.

Use 6-wire, straight-through data cables, not 4-wire telephone cables or crossover cables,
all the way from the device server to the last device on the RS485 bus. Connect ATX to ATX,
BTX to BTX, etc., with no crossover as you go from device to device.

To connect a meter with a USB board to a computer, use a USB cable with Type A and
Type B connectors. The computer will display “Found new Hardware” followed by “Welcome to
the Found new Hardware Wizard.” Follow the instructions for software installation from a CD.
When the installation is complete, use Device Manager to determine the COM port. To get to
Device Manger, go to the Windows Control Panel, click on System, click on the Hardware tab,
then click on Device Manager. Go down the device list and click on Ports (COM & LPT) and
USB serial port (COM #). Note the COM port # for use with communications to your meter,
then exit Control Panel. If you later need to change the COM port, right-click on USB serial port
(COM #), then on Properties, Port settings, and Advanced. Change port to the desired number,
click OK, then exit Control Panel.

DOWNLOADABLE SOFTWARE AND MANUALS

Windows-based software is available from Transducer Techniques to program our meters
and transmitters via a PC using the serial interface. This software can be downloaded at no
charge from http://www.transducertechniques.com. Please see Section 19 for details.

Software manuals for the Custom ASCII and Modbus Protocols can also be downloaded from
http://www.transducertechniques.com.

-29 -



BOARD SETUP VIA JUMPERS

USB Board
No jumpers required.

uUsB

RS232 Board

e - Normal operation.
f - Slave display to RS232 from another meter.

g - Pull-up resistor on RTS line.
Note: Board is shipped with jumpers e and g installed

RS-232 menfmgm

RS485 Board, Full Duplex Operation
b & d - Installed on last meter in long cable run.

RS485 Board, Half Duplex Operation

a & c - Installed for half duplex operation.
d - Installed on last meter in line with long cable runs.

Note: Board is shipped with no jumpers installed.

mam mbecCunds

RS-485

RS485-Modbus Board, Full Duplex Operation

b & e - Bias jumpers should be installed on 1 board.
a & d - Installed on last meter in long cable run.
RS485-Modbus Board, Half Duplex Operation

b & e - bias jumpers installed on 1 board.
¢ & f - installed for half duplex operation.
a - installed on last meter in line with long cable runs.

Note: Board is shipped with no jumpers installed.

Modbus

USB-to-RS485 Converter Board

Full Duplex Operation
No jumpers for short cable runs.
Add b & d for long cable runs.

Half Duplex Operation
a & c - Installed for half duplex operation.

d - Installed on last meter in line with long cable runs.

USB/RS485
mamubeCunds
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KEYSTROKES FOR SETUP
If the MENU 2 key does not work, see Section 8 “Enabling & Locking Out Menu Iltems.”

MENUKEY 2>, R SE-ECT o > VALUE SELECTKEY | A
| SEr 1 | 000 [} Send unfiltered signal
Fixed Parameters: | Output filtering il Send filtered signal
No parity
8 data bits 000 300 baud
1 stop bit Baud rate d 600 baud
P 1200 baud
2400 baud
Bl 4800 baud
B 9600 baud
B 19200 baud
| 000] 60 Hz 50 Hz
Output update rate [} Line frequency Line frequency
d 0.28sec 0.34 sec
Pl 0.57 sec 0.68 sec
1.1 sec 1.4 sec
Pl 23sec 2.7 sec
E 4.5sec 5.4 sec
B 9.1sec 10.9 sec
18.1 sec 21.8 sec
B 36.6 sec 43.5 sec
[} 72.5sec 97 sec
| SEr 2| 0000 [} No line feed after carriage return
Serial Setup 2 Line feed ﬂ Line feed after carriage return
0000 [} No alarm data
Alarm data with readings ﬂ Alarm data with reading
0000 [} Continuous data output
Control of data output d Data output on ASCII command only
0000

Select &thru %‘or addresses 1 thru 15.

Serial Setup 3

Meter address with Custom | Select 1A thru [g@ (with decimal point) for
ASCII protocol addresses 16 thru 31.

00000 W Full duplex

Half or full duplex i Half duplex

00000 [} Standard continuous mode

Special start & stop char. ﬂ Special start & stop characters
00000 [} Normal RTS

RTS mode il Single transmission

00000 % Only at end of all items

Termination characters

At end of each item
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MENU KEY | >

DIGIT SELECT >

TARE

VALUE SELECT KEY | N\

MENU KEY PEAK RESET
00000 [l Reading
Serial Setup 3 Data sent in continuous d Peak
(continued) mode Pl Valley
Reading + peak
Pl Reading + valley
E Reading + peak + valley
SEr 4] [ 1sec
Serial Setup 4. Modbus ASCII gap timeout d 3sec
Pl 5sec
B 10sec
| 000 [} Custom ASCII
Serial protocol d Modbus RTU
P Modbus ASCII
[ 000 [} None, 2 or more stop bits
Parity il Odd, 1 or more stop bits
P Even, 1 or more stop bits
| Addr |_oool 000j@ 000
Modbus Address. Select digit to flash. Select i) through ] for flashing digit.

Appears only if the
Modbus protocol is
selected.

Address range is 1 to 247.
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SERIAL CONNECTION EXAMPLES

Meter with USB,RS232 or
RS485 serial interface board

RS485 hub via RJ11 connectors
USB cable and 6-wire data cables

Host computer Meter with USB-to-serial Meters with RS485 |/O boards,
converter board each with two RJ11 connectors
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| 17. EXCITATION OUTPUTS & POWER SUPPLY I

Three isolated transducer excitation output levels are available from the power supply board.
These are selectable via jumpers b, c, d, e, f in the upper right of the board, as illustrated.
In addition, the board provides three jumper positions for special features. The same jumper
locations apply to the universal power supply (85-264 Vac) and to the low voltage power
supply (12-32 Vac or 10-48 Vdc).

0000 ooon
bcd e f
a hg
pog 00O
Excitation output Jumper locations
b d e
5 Vdc £5%, 100 mA max b,d, e | BN BN BN B B B
0 b d f
10 Vdc £5%, 120 mA max b,d,f EEEE EEBHE
24 Vdc £5%, 50 mA max c c
HE BB Rl B RN

SELECTION OF OTHER JUMPERS

Jumper a - Front panel menu lockout, locked when installed. (See Section 8)
Jumper g - Provides +5V power output at P1-4 when installed.
Jumper h - Connects "Control Input 2" to P1-4 when installed.
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| 18. DIGITAL CONTROL INPUTS I

18.1 FUNCTION OF DIGITAL INPUTS

Tare Logical 0

Logical 1
Poak Dispay  Logical 0
Valley Display Logical 1
Hold Logical 0

Meter Reset

Logical 1
Logical 0

Logical 1

Function Reset Logical 0

Logical 1

18.2 MENU SELECTIONS

Current display value is set to zero and is stored as offset value.
Displayed value equals signal input less tare value.

Peak or Valley value of input signal is displayed.

Current value of input signal is displayed.

Meter display and outputs are held at last reading prior to hold
going low.

Display and outputs are updated normally.

Microcomputer reads and resets meter to values stored in non-
volatile memory.

Meter display and outputs operate normally.
Microcomputer resets peak to current value, and resets alarms.
Meter display and outputs operate normally.

MENU DIGIT TARE
KEY | | | SELECTKEY | e ..
| SEtuP) (00 (00
Press the | = 12345 12345
until SEtuP Press [z to select digit Press 5 to set value for flashing digit.
(meter setup) | 5, which will flash. [} A=Reset B = Meter Hold
is displayed. d A = Function Reset B = Peak or Valley Disp.
P A = Meter Hold B = Peak or Valley Disp.
A=MeterHold B =Tare
Pl A = Peak Display B = Tare
B A=Tare B = Reset
B A=1,B =1, decimal point 1= XXXXX
. . A =0, B =1, decimal point 1 = XXXX.X
Eoéh ":;‘pti /; fnnc‘:ignsggtsoes for selections | A = 4. B =0, decimal point 1 = XXX.XX
= s = A =0, B =0, decimal point 1 = XX.XXX
Both inputs A and B set to 1 for selections A =1,B =1, decimal point 2 = XXXX.X
(. @ E 8 B E B, & = Meter Reset A =0, B = 1, decimal point 2 = XXX.XX
External decimal DP1 & DP2 control the A =1,B =0, decimal point 2 = XX.XXX
decimal point positions and override the A =0, B =0, decimal point 2 = X.XXX.X
decimal point selection in SEtuP. B A= Function Reset B = Display Blank
8 A=Hold B = Display Blank
I A = Peak or Valley B = Display Blank
B A=Tare B = Display Blank
A = Valley Display B = Peak Display
M A=Tare B = Tare Reset

1

(98]

(V)]
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| 19. INSTRUMENT SETUP & DATA DISPLAY VIA PC I

DPM-3 Instrument Setup software is a PC program which is much easier to learn than front
panel programming. It is of benefit whether or not the meter is connected to a PC. With the
meter connected to a PC, it allows uploading, editing and downloading of setup data,
execution of commands under computer control, and the listing, plotting and graphing of
data. With the meter unconnected to a PC, it provides quick selection of jumper locations
and a printable display of menu selections for front panel setup.

SOFTWARE INSTALLATION

Download DPM-3 Instrument Setup from www.transducertechniques.com onto your PC.
Double-click on the downloaded file to unzip it into a special directory, such as c:\Program
Files\DPM-3\IS. Within that directory, double-click on setup.exe, which will install the
software on your PC. Prerequisites for connected use are the following:

e DPM-3 meter with a DPM-3-OPT-T (RS232 option) or DPM-3-OPT-U (USB option).

e PC-compatible computer with an available RS232 or USB port.

e RJ11-to-DB9 RS232 cable (P/N DPM-3-RJ11AD9) or commercial USB cable to connect
the meter to the PC.

e DPM-3 Instrument Setup software.

ESTABLISHING COMMUNICATIONS

Connect the meter to the PC. Apply power, and keep the meter in RUN Mode. To start the
software from Windows, click on Start > Programs > DPM-3 Digital Panel Meter > DPM-3
Instrument Setup. Select the proper COM port and baud rate. Click on RS232 > Establish.
The program will temporarily set the selected COM port to the required baud rate, parity,
data bits and stop bit. Once communications have been established, click on Main Menu.

[~ Fein commmeanorm ~ici = i
Com Ports Baud Hate Frotocol | Establish I Select Instrument and Series
@ Com1 ’ }
e S & Custam ASCIT Panel Meter Transmitter
Com 2 C 600 € Madbus RTU
C Com3 1200 C Modbus ASCIT & DPM " Analag Tnput
C Com 4 C 2400 Hul
Ap 2
 Com 5 4800 — C Weight Meter
e ATty
' Com 6 & 9600 . " Counter/Timer " Counter/Timer
O Com 7 £ 19200 Lo Back
© ComR
O Com 9 Quit Series
b C Series 1
Other Com Port
 Series 2
| Wait while pting to establish
Bark Chuit

Meter Type
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CECTE =10/ =)
Input+Display Scaling Filter iRelay Alaumél C icali { Analog Out T Lockouts
Input+Display|__ Scaling | Filter | Relay Alamms | C jcatior] Analog Dut | Lockeuts ~Alarm 1 - Alarm 2
O BASIC Ot Sig Cond Option Relay Dption Comm Option Analog Dption Seipoint 1 Seipoint 2
phon
® EXTENDED Boards “ ~| ’]Relay Board v| “REZaZ Board * “Nnne Ea \ +010000. \ |+“2"“°" |
Deviation 1 Deviation 2
rSignal Input “ +000000. | “ +000000.
Mode Range Custom Curve Rate 50/60 Hz Line Freq = =
| Alarm OULTE Alavm ource
“DE v =l ’] 0.2 =l ’]Disahled =l “Disahled =l ’V|5n Hz j‘ “m " J—‘ “m 7 JT
e re: exe
—Display Alarm 1 State Alavm 2 State
Resolution Display Filter Decimal Point Peak Button Action - Auto Tare “ High Active j “ High Active v
’]4. 5 Digits j ’]Filtered J ’Vddddd J—‘ ’VFeak J‘H’lmsabled j Relayl Alrm State Relay2 Alrm State
“ Active On 7| [ [aciveon =]
Deviation 1 Type Deviation 2 Type
“ Band Dwiat'nj ’7 Baml Deviat" nJ
r Control Inputs Alarm 1 Type Alarm2 Type
Control Input A —-—-————- Control Input B —----——----—— Both Ctrl A, B ( Mo Latching v [ Mon-Latching 7|
X - X -
’VIMeter Reset Meter Hold Cold Reset j I o Laicking I on Latching
Alarms 1.2 No.Rigs to Alarm
{ 1 Reading T [~ Mo Deviation in Menu
Main Menu | Main Menu

SETUP OF CONNECTED METER

A setup file can be retrieved from the meter (DPM => Get Setup), be edited (View =>
Setup), be saved to disk (File => Save Setup), be retrieved from disk (File => Open Setup),
and be downloaded into one or multiple meters (DPM => Put Setup). Downloading of setup
files from a PC can be a major time saving when multiple meters have to be set up in the
same way.

You will find that DPM-3 Instrument Setup software is very user friendly, with separate tab-
selectable windows for Input+Display, Scaling, Filter, Relay Alarms, Communications,
Analog Out, and Lockouts. If the required hardware, such as the analog output board, is not
sensed, the corresponding tab will be grayed out.

ADDITIONAL FEATURES

e The Commands pull-down menu allows you to execute certain meter functions by using
your computer mouse. You can reset individual meter functions, display current or peak
readings, and enter numbers to be displayed remotely by the DPM. The first position of a
transmitted number must be a blank, + sign or - sign. Five digits and a decimal point must
be transmitted. Leading O’s serve as blanks. The Commands pull-down menu will be grayed
out unless a Get Setup has been executed.

2900. 4 |
2875,

T2 e e e e o
2850,
2825. 1Y I T | N
2800.

512 4 - - e
2775,
2750.

L R R LLLCCEEPPEEERPREEREPE © | 1 & R L R
2725,
2700. 1]

2725, 2750, 2775, 2800 2825 2850, 2875
Print Save | Pause | Continue | New Scale End
Plot Graph
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e The Readings pull-down menu provides three formats to display DPM data on the PC
monitor. Use the Pause and Continue buttons to control the timing of data collection, then

press Print for a hardcopy using your PC printer.

- List presents the latest readings in a 20-row by 10-column table. Press Pause at any

time to freeze the display. Press Print
for a hardcopy LISt Can Capture peak w. DC Signal Conditioner Calibration

=101 ]
readln S. Select Range 200 mv DC ‘-
g ] ’7 Zero - ..‘:B:‘F
- l?lot generates a plot of readings vs. pooc— |l n‘\g*
time in seconds. It effectively turns the O *h
H H H H 1 Scale Factorsetto 10 |
DPM-PC Comblnatlon Into a prlntlng Calib Desired | Current Current New New E
d|g|ta| OSC'”OSCOpe. Input Reading | Reading Calib Calib  |Reading Accept
0vDC 0 +00003 FFFB FFD6 -00003 1
- Graph generates a histogram, where L0003 e —
the horizontal axis is the reading and -00002 FFE2  FFFB  +00000 —4 !
the vertical axis is the number of 5
occurrences of_ reac_jings. The display ——
continually resizes itself as the num- —= |

ber of readings increases.

2]

=

=]
=

End

e The Jumpers pull-down menu provides
jumper positions for the various meter boards, duplicating information in this manual.

METER SETUP WITH AN UNCONNECTED PC

DPM-3 Instrument Setup software is also of benefit [MENUKEY [S [1 ]2 |3 [4 |5
when the PC is not connected to a meter. Upon launch- | nPut d ¢ v
ing the software, click on None for Communications, | SEwP___ 0 0 0 0 0
then on DPM-3 and Continue. Click on File => Default |€onfi6 0 /0 0 0 0
Setup to retrieve a default setup file from disk, oron File |FLEr 0 0 1 1 6
=> Open Setup to retrieve a previously saved setup file | Decft  d d d. d d
from disk_ SCALE 0 00 1 0
OFFSt 0 0D 0.0 O
To enter new setup information, click on View => Setup, | sgr1 0 5 0
then make your screen selections as if you were | ggr2 00 1 1
connected to a meter. Tabs will be grayed out if you | pLee1 0 0 0 0 O
have not selected the required hardware under the | poc2 00 1 0
Input+Display tab. When done, press on Main Menu, | Loc3 0 0 0 0
then on View => Menu. The selections made under
Setup will now be shown in the form of the required front
panel programming sequence, where each row corre-

sponds to a menu item selected by the E4 key, and the

Click on any step in the sequence to bring up a detailed help window. Click on Print for a
hardcopy, which you can then use as an instruction sheet to program your meter via its front
panel. Click on Main Menu => File => Save Setup As to save your setup to disk and have

an electronic record.
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| 20. CUSTOM CURVE LINEARIZATION I

Curve.exe is a DOS-based, executable PC program used to set up an Extended meter so that
the readings have a user-defined, non-linear relationship with the input signal. The calculated
linearizing parameters are downloaded into non-volatile memory of the meter. For example, it
allows a meter to correct for transducer nonlinearity or to display volume of an irregularly

shaped tank based on pressure mea-
sured at the bottom of the tank. The Tank Volume from Pressure
curve-fitting algorithm uses quadratic at the Bottom of the Tank

segments of varying length and curva-
ture, and provides diagnostics to esti- 7:4
mate curve fitting errors. The program is Nk
self-prompting, avoiding the need for a

detailed printed manual. This manual

section is only intended as an intro-

duction.

PREREQUISITES

1) PC-compatible computer with an available USB or RS232 communications port.
2) Extended DPM-3 meter.

3) A USB or RS232 board in the meter. This board can be used for meter setup only, then
be removed.

4) USB cable, A to B, or RS232 cable, RJ11-to-DB9 (P/N DPM-3-RJ11AD9), to connect
the meter and PC.

5) Curve.exe software, available from Transducer Techniques.

GETTING STARTED

Download curve.exe into the same directory that will contain your data files, such as
c:\curves. Set the meter baud rate to 9600. To do so, press the B key to get to g, then
set the entry to IlEY. Set the meter address to 1. To do so, press the B key to get to I3}
P, then set the entry to IfiEK]. To execute the program from Windows, simply double-click
on curve.exe, which is an executable file. Follow the steps on computer screens, which will
prompt you and provide extensive information. Pressing R (Enter) returns to the main menu.
You will be given the choice to enter your data in one of four modes:

1) Text file entry mode, with an X value in one column and a Y value in another. There
can be additional columns, which are ignored. The file must have a DOS name of up to
8 characters and the extension .RAW. There can be from 5 to 180 rows. X is the input
value and should be in the unit of measure for which the meter was set up, such as mV
or V.Y is the desired corresponding reading, and can range from -99999 to 99999 with
any decimal point.

2) 2-coordinate keyboard entry mode, where an actual X input signal is applied, and the
desired Y reading is entered from the keyboard.

3) 2-coordinate file entry mode, where an actual X input signal is applied, and the
desired Y reading is provided from a file.
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4) Equation entry mode, where the coefficients of a polynomial Y = K1X*P1 + K2X*P2 +
K3*XAP3 + ... are entered. Up to 20 terms are allowed. An offset can be built into X.

You will be asked if your DPM has a revision of DPM4L or later. You will normally select 2
(yes), since revision DPMA4L started to ship in August 2000.

You will be asked to supply the following:

LOW X-COORDINATE VALUE >
LOW INPUT MEASUREMENT VALUE >
HIGH X-COORDINATE VALUE >
HIGH INPUT MEASUREMENT VALUE >

This informs the computer of your signal conditioner jumper settings. Enter 0 and O for
the two LOW values. For HIGH X, enter your signal conditioner jumper range in the
same units of measure that you will be using in your *.RAW data input file. Enter 20 for
20 mV or 50mV. For HIGH INPUT MEASUREMENT VALUE, enter 20000

Position of the decimal point from 6=X.XXXXX, 5= XX. XXX, 4=XXX. XXX, 3=XXXX.XX,
2=XXXXX.X, 1=XXXXXX (for DPMs, the leading X is a blank). Specify the same position
that you specified in the [ a decimal point menu selection.

Follow the steps on the screens to finish generating the custom curve. When prompted to
download the file to the meter, select Y. When prompted to set the meter to custom curve
mode, also select Y.

KEYPAD CONTROL

You can take a meter in and out of custom curve linearization using the meter keypad.
From the Menu mode, press the H key to get to [3ae), then set the fifth digit to either i
(normal linear operation) or to fl (custom curve operation). This fifth digit will only be
displayed with an Extended meter.

FILES USED OR CREATED BY CURVE.EXE
1) *.RAW is the raw input file generated by all four data entry methods.

2) *.DVD adds three columns from which the smoothness of the input data and obvious
input errors can be judged. The more data points and the smoother the data, the better
the curve fit.

3) *.NUM lists Y readings prior to custom curve linearization and addition of the decimal
point.

4) *.CCF is an internal file used by the software.
5) *.SIM lists simulated linearized meter readings and calculated corresponding errors.
6) *.PRM contains the final hex data that is downloaded into the meter.
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| 21. METER CALIBRATION I

All analog input and analog output ranges of the meter have been digitally calibrated at the
factory prior to shipment using calibration equipment certified to NIST standards. Calibration
constants are stored digitally in non-volatile memory in EEPROM on the signal conditioner
board and analog output board. As a result, these boards may be mixed and interchanged
without requiring meter recalibration. Digital calibration eliminates much of circuitry that would
be associated with analog calibration, providing superior long term accuracy and stability.

Annual meter recalibration by the factory is recommended. Please contact Transducer
Techniques for an RMA number.

| 22. SPECIFICATIONS I

Display
TYPE oo 5 LED, 7-segment, 14.2mm (.56") high digits & 3 LED indicators
L7 0] [ SRR Red
= Lo = USRS -99999 to +99999
TEDS Status INdiCator........... i Yellow LED lamp
TEDS Status.....cccoooeeeeieecceee e, With a TEDS transducer, lamp lights with TEDS

enabled and in Plug and Play mode
A-TO-D Conversion

Read Rate .....coueiii e 60/s for 60 Hz NMR, 50/s for 50 Hz NMR
Output Update Rate .........cooovviiiiiiiiiiic e 56/s at 60 Hz, 47/s at 50 Hz
Display Update Rate ........ccooovieiiiiiee e 3.5/s at 60 Hz, 3/s at 50 Hz
Noise Rejection
CMV from DC tO B0 HzZ......eeeeeeeeeeeeeee e Withstand 250Vac
Dielectric strength...........cccoooiiiiiiii 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
CMRFromDCtOBO HZ ... 130 dB
NMR at 50/60 Hz........ooumiiiiiiiiiieiiieeeeeeeeeeeeeeee e 90 dB with minimum digital filtering
Control Inputs (CMOS/TTL levels, logic 0 = tied to digital ground, logic 1 = open)
THOIA INPUL .. Logic 0 holds display and outputs
[ Peak or Valley input ........ccoooiiiiiiiiiicc e Logic 0 displays peak/valley value
1= 1= o1 | Logic 0 offsets input value to zero
[ Tare RESEL ... Logic O resets Tare value to zero
T RESEet INPUL ..o Logic O resets all meter functions
/ Function Reset input ..........ccooeiiiiiiiiiiiieeeeee Logic O resets peak values and alarms
/ Decimal Point input ..................... Overrides internal DP selections and controls DP position
/ Display Blank input ..........ccooooiiiiiiiiiieeeeeee e Logic 0 shuts off the display
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Accuracy

Input Range | Resolution QMU | QL e Error at 25°C
Range Range
20.000 mV 1uVv
50.000 mV 2.5V -99,999 0 0.01% of
100.00 mV 5uVv to to Full Scale
250.00 mV 12.5 yv +99,999 +99,999 12 counts
500.00 mV 25 uv
Span Tempco (load cell signal conditioner).............ccccoe, 0.0015% of reading/°C
= o T =Y o 0] o oo S 0.2 yv/°C
Power Requirements
Input Voltage rating (standard)............coooeviiiiiiiiiiiiiiiiiiiiiieeeeeeee 85-264 Vac or 90-300 Vdc
Input Voltage rating (low voltage option) ...........ccceeeiiiiiiiiiiiiiiceeee, 12-32 Vac or 10-48 Vdc
POWEr LiN€ FIrEQUENCY .....eeeeiiiiiiiiiiiiiiiiieeieeeteeteeeeeee s sseesseneeenne DC and 47-63 Hz
Power ConsumpPion, MaX .......cooouuiiiiiiii ettt 5 Watts
Excitation Outputs
Voltage & Current Levels (jumper selectable) ............ccccvvvvvveeeeenn.n. 5 Vdc 5%, 100 mA max
10 Vdc £5%, 120 mA max
24 VVdc + 5%, 40 mA max
Excitation Output RIpPIE......ooeeieeiee e 100 mVp max
Isolation from power and OULPULS ..........coeeiiiiiiiiice e 250 Vac
Insulation dielectric strength to power and outputs..... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Isolation to Signal COMMION .........oouii e 50 Vdc
Dual & Quad Relay Options
Power to Relay Option ............uuuieiiiiiiii e Powered by meter
Setpoint Setup.......coeeeeiiiiiiiiii, Via front panel pushbuttons or serial communication
Update Rate ........coooeiiiii e 56/s at 60 Hz, 47/s at 50 Hz
Response to input signal (Min)........cccooeioiiiiiiie e, Display update rate
Input Signal (selectable).............ooviiiiiiiiiiiiiiiieeee Filtered or unfiltered input signal
Actuation Modes (selectable)...... Above or below setpoint, latching or non-latching, disabled
Output Time Delay (selectable) ... 1 to 128 readings
Front Panel Enable / Lockout Modes (selectable)................ 1) Display and change setpoints

2) Display but do not change setpoints
3) Neither display nor change setpoints

Alarm Status INdiCation ...........coooiiiii e 2 or 4 red LED lamps
Status Indication Setup (selectable)....................... Lit when output is ON or OFF, or disabled
Form C, SPDT Relay Output:

O - 1 o [P 8A @ 240 Vac
DC RALNG....uiiiei et e e e e et e e e e e 8A @ 24 Vdc
Isolation rating between signal common and contacts ............ccccoeeeiiiiiiiiiiiiiiien e, 250 Vac
Insulation dielectric strength between signal common and contacts ..........cccccccooiiiiiin,
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min



Form A, SPST Solid State Relay Output:

X O <= | 1] o PSS 120 mA @ 140 Vac
DC RaAIING . ..ttt s 120 mA @ 180 Vdc
Isolation rating between signal common and contacts ..............ccccceeeiiiiiiiiiiiiiiie e, 250V ac
Insulation dielectric strength between signal common and contacts ............cccccvvvvvviiiiiiiinnnnnn.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Analog Output Option
Power to Analog Output Option...........ccooiiiiiiiiiiie e Powered by meter
Output Levels ..., 0-20 mA, 4-20 mA, 0-10V, -10 to +10V
Voltage Compliance, 0-20 mA Output...........ooommiiiiiiiieieeee 12V (0-600 Ohm load)
Current Compliance, 0-10V, -10 to +10V Output....................... 2 mA (5 kOhm or higher load)
ACCUIACY ..eeuiiiiiieeieeeeiiiee e Meter input accuracy £0.02% of full scale analog output
RESOIULION ... eeeenee 16 bit (1 part in 65,536)
RESPONSE TIME ..eniiieee e eeeanas 50/60Hz update rate
Scaling of Reading for Zero Output...........ccooviiiiiiiiiii e -99,999 to +99,999
Scaling of Reading for Full Scale Output.............coooviiiiiiiiie e, -99,999 to +99,999
Isolation rating between signal common and analog output.............cccoeeeiiiciieneeeeee. 250V ac
Insulation dielectric strength between signal common and analog output.................coeiiii
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Serial Interface Option (USB, RS232, RS485, RS485-Modbus boards)
Output Types.....cccceveeeeennnee. RS232, RS485, RS485-Modbus, USB, USB-t0-RS485 converter
Power to Interface OptioN.............ueuuueiiiiiiiiiiii e Powered by meter
RS485 WIFING ...ttt e et e e e e e e e Half or full duplex
Baud Rates ............eeeeiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeee 300, 600, 1200, 2400, 4800, 9600, 19200
Serial Protocols ........ccccceeeeevieeennnn, Custom ASCII, Modbus RTU, Modbus ASCII (selectable)
Signal Levels ... Meet RS232, RS485, USB standards
Isolation rating between signal common and serial 1/O ............ccccooeiiiiiiiiiiiiiiiee e 250V ac
Insulation dielectric strength between signal common and serial /O ............ccoooviiiiiiiiiiiiiinnnne.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Option Board Connectors:
RS 23 e a—————— Single RJ11 jack
RS485 ... Two RJ11 jacks (for daisy chaining with 6-wire data cables)
RS485 (for Modbus std) ........ Two RJ45 jacks (for daisy chaining with 8-wire data cables)
] = TP P PP TP PTRPPTPRRRRRPRRNE USB type B plug
USB-t0-RS485 converter.........cccccccceeeenen.. USB type B plug plus RJ11 jack to RS485 bus
Environmental
Operating TEMPEFAUIE ..........uuiii i e 0°C to 55°C
Storage TeMPErature .......coooo i -40°C to 85°C
Relative Humidity ............cooiiiiiii e, 95% from 0°C to 40°C, non-condensing
Case.....ooeeeiiiiiiis NEMA-4X (IP65) from front when panel mounted (not verified for UL)
SOCK e 10 G at 1 kHz, applied in X, Y, Z axes
Vibration ........ccooeeviiiiiie, 15 Hz to 150 Hz, 1 mm to 2 mm amplitude, 20 G max.
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| 23. GLOSSARY OF TERMS |

Adaptive Filter Threshold

A threshold which causes an adaptive moving average filter to be reset to the
latest reading when the accumulated difference between individual readings
and the filtered reading exceeds that threshold. Adaptive moving average
filtering allows the meter to respond rapidly to actual changes in signal while
filtering out normal noise. The accumulated difference is also reset to zero
when the latest reading has a different polarity than the filtered reading. A low
adaptive filter threshold is normally selected. A high filter threshold should be
selected if the signal has large transients.

Alarm, Latched s
Setpoint .~ ON ™,

An alarm which stays actuated until reset. (1000
Latched alarms can shut down machinery or
a process when an operating limit has been
exceeded, or maintain an alarm condition
until acknowledged by an operator.

OFF ON ™.

Alarm, Non-latched LATCHED ALARM

An alarm which changes state automatically
when the reading rises above a specified limit
and changes back automatically when the
reading falls below a limit. T

Setpoint / ON ™,

Meter Reading

Time

Autofilter A selectable digital filter mode which auto- |1000
matically selects an appropriate moving aver-
age filter time constant from 0.08 sec to 9.6

sec for the encountered noise condition. OFF OFF

Meter Reading

Auto-tare A selectable meter operating mode, where
the first reading following power-on or meter
reset is used to zero the display. Further Time
readings are then relative to this new zero.

NON-LATCHED ALARM

Batch Average Filter
A digital filter mode which averages 16 readings and then displays the average.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.

Counts The reading displayed on the meter ignoring the decimal point.

Custom ASCII Protocol
A simplified serial communications protocol which allows 31 digital addresses.
Not an industry-standard protocol like the more complex Modbus protocol,
which is also offered with the meter.

Deviation Band
A band in counts which controls relay action symmetrically around a setpoint.
The relay actuates when the reading falls within the deviation band, and de-
actuates when the reading falls outside. A limit (e.g., 50 counts) is set up
around both sides of the setpoint to create a deviation band (e.g., 100 counts).
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often used for component testing. Deviation . .
limits are programmed by entering menu item |, 50| 72! .
dEU1b for Alarm 1 and dEU2b for Alarm 2. |,45|725® «* *e *
The deviation band will be equal to two limits. | gsg| PSS, % > Setp°'”t & e
Fa|I .

Display Blank A rear panel input which blanks the display §’ % Setpoint = 1000
when the input is tied to logic ground by a § Deviation limit = 50
switch or OV is applied (logic level true). The Deviation band = 100
meter display will light when the input is open Parts

Setting up a passband around a setpoint is

or is held at +5V (logic level false).

Extended Meter

Full Scale

A meter with an enhanced microcomputer that provides added capabilities,
such as linearization of nonlinear inputs and display of rate of change from
successive readings.

The maximum input signal range for which the meter has been configured. For
example, the most sensitive full scale for the load cell meter is £20 mV (signal
range from -20 mV to +20 mV).

Function Reset

A rear panel control input which resets Peak, Valley and any latched alarms
when the input is tied to logic ground by a switch or OV is applied (logic level
true). To reset the value again, the input must be open or 5V applied (logic
level false) and then set low.

Ground Loop A closed conductive path in external ground wiring that allows stray currents to

Jumper

Hysteresis Band

flow in ground wiring, creating ground noise. The meters in this manual mini-
mize ground loop problems by mutually isolating the grounds associated with
meter power, signal input, and all output and communication options.

A push-on component which provides a short between two adjacent posts on a
circuit board. Jumpers are used to configure the load cell signal conditioner
board for specific full scale ranges, and to configure power supply and commu-
nications boards for various modes of operation. Unused jumpers are stored by
pushing one side over an unused post.

Heater Heater Heater

A band which controls relay action symme- . OFF A OFF A OFF

trically around a setpoint. The relay closes |1050
(or opens) when the reading goes above |44, Heater\ Heater Heiﬂer\
the setpoint plus one hysteresis limit, and K JON \ @N \ oN \
opens (or closes) when the reading falls !

below the setpoint less one hysteresis limit.
A narrow hysteresis band is often used to
minimize relay chatter around a setpoint
due to electrical noise or signal feedback Time
caused by load switching. A wide hysteresis band can be used for control
applications, such as turning on a fill pump when the tank level has reached a
lower limit and shutting off the pump when the tank level has reached an upper
limit. The hysteresis band will be equal to two hysteresis limits.
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Menu Mode

Meter Hold

Modbus

The meter programming mode used for input and range selection, meter setup,
and meter configuration. Entered into from the Run mode by pressing the
MENU key. The Menu mode can be locked out completely by a jumper.

A rear panel input which freezes the meter display and all meter outputs while
that input is tied to logic ground by a switch or is held at OV (logic level true).
The meter will resume operation when the input is allowed to float or is held at
+5V (logic level false).

An industry-standard serial communications protocol which allows devices by
different manufacturers to be digitally addressed by a PC on the same com-
munication line, with up to 247 digital addresses. More complex than the
Custom ASCII protocol, which is also supported by the meter.

Moving Average Filter

Offset

Peak Display

A digital filter mode which displays a weighting moving average of readings.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.
Display update rates remain 3.5/sec with 60 Hz power and 3.0/sec with 50 Hz
power. There are eight moving average modes:

Old average x 1/2 + new reading x 1/2 (equivalent to 0.08 sec RC time constant).
Old average x 3/4 + new reading x 1/4 (equivalent to 0.15 sec RC time constant).
Old average x 7/8 + new reading x 1/8 (equivalent to 0.3 sec RC time constant).
Old average x 15/16 + new reading x 1/16 (equivalent to 0.6 sec RC time constant).
Old average x 31/32 + new reading x 1/32 (equivalent to 1.2 sec RC time constant).
Old average x 63/64 + new reading x 1/64 (equivalent to 2.4 sec RC time constant).
Old avg. x 127/128 + new reading x 1/128 (equivalent to 4.8 sec RC time constant).
Old avg. x 255/256 + new reading x 1/256 (equivalent to 9.6 sec RC time constant).

A constant adder used for the displayed reading. This is the term b in the
straight line formula y = mx + b, where y is the displayed reading in counts, m
is the scale factor, x is the measured reading in counts, and b is the offset. For
direct readout in (milli)volts or (milli)amps, offset is 0.

The maximum (or most positive) reading since that maximum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.

Rate of Change Meter

Reading

A configuration mode of the Extended meter which allows the display of rate
based on successive readings. The conversion to engineering units is achieved
with the combination of a multiplier from 0.1 to 10,000 and a scale factor.

The value displayed by the meter. “Taking a reading” is the action of the meter
to make an analog-to-digital conversion. Readings are taken at 60/sec with 60
Hz power or 50/sec with 50 Hz power, and are displayed with an update rate of
3.5/sec with 60 Hz power or 3.0/sec with 50 Hz power.
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Remote Display

Reset

A display mode which allows the meter to serve as a remote display to another
meter when connected to it by a 4-wire phone cord. Also allows the meter to
transmit raw measurement data to a computer and then display processed data
from the computer. A serial communications option board is required in the
meter. If such a board is not installed or no serial data is received, the meter
displays rESEt.

There are three types of Reset:

» Peak and Valley Reset. Achieved by simultaneously pressing the RESET
and PEAK keys.

= Latched Alarm Reset. Achieved by simultaneously pressing the RESET and
ALARMS keys.

= Meter Reset. Causes the meter to reinitialize and take a tare reading when
set up for auto-tare. Achieved by powering up the meter, simultaneously
pressing the RESET and MENU keys, stepping through all top-level menu
choices, grounding a rear panel connector, or supplying an ASCIl com-
mand. rESEt is displayed briefly.

RS485 Half Duplex

Serial communications implemented with two wires, allowing data transmission
in both directions, but not simultaneously.

RS485 Full Duplex

Run Mode

Scale

Scaling

Serial communications implemented with four wires, allowing data transmission
in two directions simultaneously.

The normal operating mode of the meter, where readings are taken, as
opposed to the menu mode.

A constant multiplier used to go from A/D 8
converter counts to displayed counts. This is | >
the slope term m in the straight line formula |§ &
y = mx + b, where y is the displayed reading g § ~ High input,
in counts, m is the scale factor, x is the mea- | £.§ 51 high reading
sured reading in counts, and b is the offset. |a g N Low input,
For direct readout in mV or mA, scale is 1. o0& low reading
el Offset b
The process of setting scale and offset so 0
that the meter reads properly in engineering 0 Counts x from A/D converter
units, such as Ibs. Full span -32,768 to 32,768

Scaling, Coordinates of 2 Points Method

A scaling method where four numbers are entered manually: low input, desired
reading at low input; high input, and desired reading at high input. The meter
then applies a straight line fit. The decimal point is set by the separate dEC.Pt
menu item. If the Maximum Physical Value of the sensor exceeds 100000, the
calculated scale and offset are divided by 10 and the reading is in 10's of units.

Scaling, Scale and Offset Method

A scaling method where scale and offset are entered manually.
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Scaling, Reading Coordinates of 2 Points Method

Setpoint

Span

A scaling method, where the low and high input values are determined from
actual signals. A known low signal is first applied to the meter, such as the
output of a pressure transducer at zero pressure. That signal is captured as the
low input value, and the desired low reading is entered. A known high signal is
then applied, such the output of a transducer for a know weight or pressure.
That signal is captured as the high input value, and the desired high reading is
entered. The meter then applies straight line fit. This scaling method has the
advantage of calibrating the transducer and meter as a system. The actual
voltage or current at either point does not need to be known. The decimal point
is set by the separate dEC.Pt menu item.

A value compared to the reading to determine the state of a relay. Term often
used interchangeably with “alarm setpoint.” The relay action can by latching or
non-latching, utilize a hysteresis band, or utilize a deviation band. Hysteresis
bands and deviation bands are specified by two symmetrical limits around the
setpoint.

The number of counts corresponding to a given signal range.

Split Hysteresis

Tare

TEDS 1451.4

A hysteresis mode where a setpoint and a

single-side hysteresis limit are entered. That Heater  Heater Heater
limit can be negative or positive. If the limitis |10 _~OFF n OFF p OFF
negative, the relay will close below the hys- HaﬁiE,\Heé-ﬂ Heﬁier\
teresis limit, for example to turn on a heater, SON Ny On

and open when the setpoint is reached. If the
limit is positive, the relay will close when that
limit is reached, for example to turn on a
cooler, and open when the setpoint is
reached. Split hysteresis is an alternative to Time

Sefpaint = 1000
Hysteresis limit =-50

Reading E

normal hysteresis, where the setpoint is at
the center of a symmetrical hysteresis band.

A rear panel input which causes the display to be set to zero when the input is
momentarily tied to logic ground by a switch or is held at OV (logic level true).
When the input is allowed to float or is held at +5V (logic level false), the meter
displays readings relative to this new zero. A common application is in
weighing, where an external Tare button is pressed to read the weight of an
empty scale (tare), and tare is then automatically subtracted as a constant from
gross weight for display of net weight. Tare can also be used for other appli-
cations where a reading relative to starting point is desired.

TEDS, or Transducer Electronic Data Sheet, is a set of electronic data in a
standardized format defined within the IEEE 1451.4 standard that is stored in
EEPROM. This data specifies what type of sensor is present, describes its
interface, and gives technical information such as sensitivity, bridge type,
excitation, etc. With TEDS Plug and Play, the sensor and the meter are auto-
matically scaled as a system at power on.
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Valley Display
The minimum (or most negative) reading since that minimum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.

Zero An adjustment so that a given low transducer output reads zero on the meter.
Zero is adjusted by programming offset.
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| 24. ACCESSORIES |
DPM-3-AD9

Adapter Connector

INSTALLATION INSTRUCTIONS

1. Remove the three (3) connectors from the J5 location at the rear of the DPM-3 meter
(See DPM-3 Operator Manual, Page 6, Section 5.1 for illustration of J5 location)

2. Install the DPM-3-AD9 Adapter Connector at the J5 location

Wiring Diagram / Schematic
Figure 1 NON-TEDS Load Cell / Torque Sensor

Full Wheatstone Bridge

Transducer J \
Load Cell '-‘L_F" MLP Series
Force Sensor Load Cell
Torgue Sensor
Pressure Transducer \ {

Female DB9 Connector

Attached to Load Cell | [ ]
— + Signal (Green)
o 58803 ) + Excitation (Red)
2299 —— — Signal (White)

— = Excitation (Black) & Shield

e ¢—— Ground ( Shield )

Figure 2°  TEDS IEEE 1451.4
Smart Load Cell / Torque Sensor

Full Wheatstone Bridge

Transducer J \
Load Cell ‘? MLP Series
Force Sensor Load Cell
Torque Sensor
Pressure Transducer 3 (

|_ + Signal (Green)

f; I + Excitation (Red)

Install Jumper between Pins 3 & 4

0 5 gg é g ol — TEDS Data (Brown)
9999 —— — Signal (White)
— TEDS Ground (Blue)
— Excitation (Black) & Shield
Ground ( Shield )
* Compatible for use with IEEE 1451.4 compliant National Instruments devices
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DPM-3-PC6 & DPM-3-PC12
Power Cable to Meter

DPM-3-RJ11AD9
RS232 Data Cable, PC to Meter

USB-2.0-A/B
USB Cable, Type A/B, 10ft.

DPM-3-DLS
Data Logging Software

DPM-3-TRES
TEDS Reader_Editor Software

DPM-3-SFC
Splashproof Front Cover. Seals
meter against instrument panel.
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| 25. WARRANTY & REPAIR POLICY I

Limited Warranty on Products

Any of our products which, under normal operating conditions, proves defective in material
or in workmanship within one (1) year from the date of shipment by Transducer Techniques,
will be repaired or replaced free of charge provided that you obtain a return material
authorization from Transducer Techniques and send the defective product, transportation
charges prepaid with notice of the defect, and establish that the product has been properly
installed, maintained, and operated within the limits of rated and normal usage. Replace-
ment product will be shipped F.O.B. our plant. The terms of this warranty do not extend to
any product or part thereof which, under normal usage, has an inherently shorter useful life
than one year. The replacement warranty detailed here is the Buyer’'s exclusive remedy,
and will satisfy all obligations of Transducer Techniques, whether based on contract,
negligence, or otherwise. Transducer Techniques is not responsible for any incidental or
consequential loss or damage which might result from a failure of any Transducer
Techniques’ product. This express warranty is made in lieu of any and all other warranties,
expressed or implied, including implied warranty of merchantability or fitness for particular
purpose. Any unauthorized disassembly or attempt to repair voids this warranty.

Obtaining Service Under Warranty

Advance authorization is required prior to the return to Transducer Techniques. Before
returning the item(s), either write to the Repair Department c/o Transducer Techniques,
42480 Rio Nedo, Temecula, CA 92590, or call (951) 719-3965 with: 1) a part number; 2) a
serial number for the defective product; 3) a technical description of the defect; 4) a no-
charge purchase order number (so products can be returned to you correctly); and, 5) ship
to and bill to addresses. Shipment to Transducer Techniques shall be at Buyer's expense,
and repaired or replacement items will be shipped F.O.B. our plant in Temecula CA. Non-
verified problems or defects may be subject to a $75 evaluation charge. Please return the
original calibration data with the unit.

Obtaining Non-Warranty Service

Advance authorization is required prior to the return to Transducer Techniques. Before
returning the item(s), either write to the Repair Department c/o Transducer Techniques,
42480 Rio Nedo, Temecula, CA 92590, or call (951) 719-3965 with: 1) a model number; 2)
a serial number for the defective product; 3) a technical description of the malfunction; 4) a
purchase order number to cover Transducer Techniques’ repair cost; and 5) ship to and bill
to addresses. After the product is evaluated by Transducer Techniques, we will contact you
to provide the estimated repair costs before proceeding. The minimum evaluation charge is
$75. Shipment to Transducer Techniques shall be at Buyer's expense, and repaired items
will be shipped to you F.O.B. our plant in Temecula, CA. Please return the original calibra-
tion data with the unit.

Repair Warranty

All repairs of Transducer Techniques’ products are warranted for a period of 90 days from
the date of shipment. This warranty applies only to those items which were found defective
and repaired; it does not apply to products in which no defect was found and returned as is,
or merely re-calibrated. Out of warranty products may not be capable of being returned to
the exact original specifications or dimensions.

FOR TECHNICAL SUPPORT, CALL (800) 344-3965 OR FAX (951) 719-3900
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